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HOW TO USE TRADE DATA RESOURCES TO 
SUPPLEMENT THE MARKET DIVERSIFICATION TOOL 
RESULTS 
INTRODUCTION 

While the Market Diversification Tool provides important trade data that can help you identify 
potential export markets, it’s helpful to gather additional data to help you make the best 
decisions for your company. Other trade data sources can help you answer questions that the 
Market Diversification tool cannot. 

 

Trade Data 
from the 

On average, how much does 
the market import this product 
from the U.S. and the world?

What share of the market's 
imports come from the U.S.?

Are U.S. exporters 
underperforming or 

overperforming in the country 
relative to how they're doing in 

the region?

External 
Trade Data

What other countries are major 
exporters of this product?

How are other countries doing 
in the market I'm considering, 

compared with U.S. exporters?

What do the import trends in 
the country look like over time 

for this product?

How has the U.S. share of the 
market's imports changed over 

time?
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For example, using the United Nations Comtrade Database, you can see what the other major 
exporters of the product to the markets you are considering are and how their exports compare 
to the United States’ exports to that market.  
Once you have this information, you can think about why other markets may be large exporters 
of the product to the countries you are considering. Do they have FTAs with your potential 
markets that would give them preferential market access? Are they neighbors with your 
potential markets, making shipping goods easier? Do they share regulatory and standards 
schemes so the goods don’t need to be adapted to be sold in the export market? Are there 
cultural considerations that would make them more competitive in the markets you are 
considering? 
In the Comtrade database, you can also see yearly statistics on how much the country 
imported of the product from each country in the world. This is helpful for understanding trade 
patterns over time.  
Using other sources, you can find more detailed U.S. export data for more specific products 
(beyond six digits in the HS number). For example, using the USA Trade Online site, you can 
see more detailed product data and look at U.S. exports to countries over time.  
Note: the detailed data beyond six digits cannot be accurately matched to national line data 
from other countries because each country’s tariff schedule is unique at that level. 
This guide will walk you through a few trade data resources and how to use them to 
supplement the results from the Market Diversification Tool.  

Trade Data 
Resource

Used For Link

United Nations 
Comtrade Database

Identifying which other countries 
are exporting to your target 
markets, viewing import trends 
over time.

https://comtrade.un.org/

Trade Policy 
Information System

Country summary, quickly finding 
trade data on a country’s imports 
and displaying it graphically

https://tpis.trade.gov 

USA Trade Online Finding more detailed 8- and 10-
digit U.S. trade data.

https://usatrade.census.gov/ 
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THE UN COMTRADE DATABASE 

Imagine that your company exports lawnmowers, which are classified in HS 843311 in the 
Harmonized System. You are considering exporting to a small group of mostly European 
countries, and France was ranked near the top of the results in your Market Diversification Tool 
search.  
Regarding trade data, the tool gave you some information about the U.S. share of France’s 
lawnmower imports, whether the U.S. has a share gap (is underperforming) in France in this 
product, France’s average imports of lawnmowers from the world, and the average growth in 
France’s lawnmower imports over the last five years.  
At first glance, France appears to be a large market for lawnmowers, and U.S. goods make up 
more than 15 percent of France’s lawnmower imports. But French imports were trending 
downward over the period (the import growth rate was negative).  
The data in the Market Diversification Tool comes from the United Nations Comtrade Database. 
Each market collects data on its imports and exports and provides that data to the UN. 
However, the Market Diversification Tool only shows you data averaged over a five-year period. 
So you can’t see the country’s imports of a product for each year. It also only shows you how 
much a country imports from the U.S. compared to how much it imports from the world. But 
doesn’t show who the main U.S. competitors are for a product in a market. 
Now you want to know more. What other countries export lawnmowers to France? Do they 
export more than or less than the United States? If other countries sell more, why is that the 
case? What does the trade look like over time? What are the trends?   
The public site for the UN Comtrade Database provides more data than the Market 
Diversification Tool and can help you answer these questions. 
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OBTAINING DATA FROM THE COMTRADE DATABASE 

1. Once you have your results from the Market Diversification Tool, go to https://
comtrade.un.org/.  

 
Click on “Get Data.” 

2. This will open the data 
selection menu. To 
start, click “17” under 
“Classification.” This 
means you want to 
see data in the 
Harmonized System’s 
2017 nomenclature. 

 
3. Under “Periods,” select the years of data that you want to see.  

You may want just one year of data to easily see the top exporters to the market. Or you 
may want to see data over a period by selecting several years. 
To delete a year or the selection in any of the fields, click the “x” in the grey box for that 
selection. 
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4. Under “Reporters,” 
select the target market 
you are considering, in 
this case, France. The 
“reporter” is the country 
that reported the data. 
This is because you 
want to know which 
other markets France 
imported lawnmowers 
from. France is the 
“reporter” because we 
are looking for French 
data. 

5. Under “Partners,” 
delete “World” and 
select “All.” Choosing 
“World” gives you the 
total French imports 
from the whole world. 
But “All” gives you the 
results broken down 
by country. 

6. Under “Trade flows,” select “Import.” This is because you want to know what France, the 
“Reporter” imported, not what France exported. Remember, the data comes from the 
reporter. 
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7. Now select the product. Type in the six-digit HS number in the box under “HS2012 
commodity codes.” 

8. Click the green “Preview” button, and the data will appear below the menu. 
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9. If you are only looking at one year of data, you can easily sort by trade value to see the top 

exporters of the product to France. Click the grey arrow at the top of the “Trade Value 
(US$)” column until the highest values are at the top. 
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10. If you are looking at more than one year of trade data, viewing the data in the website is 
less useful. It makes more sense to download the data and view it in a spreadsheet, like 
Excel. Click the button for, “Download CSV.” The file will download. 

  

11. Open your spreadsheet program, and open the .csv file. If you can’t see the file in the 
folder when trying to open it, choose “All Files” from the menu above the “Open” button 
instead of “All Excel Files.”  
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ANALYZING THE COMTRADE DATA IN A SPREADSHEET 

12. Now let’s look at the data.  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13. At this point, the trade data is still stacked, rather than in a time series. It would be much 
easier to analyze the data if you could see imports from each country with the years next to 
each other. Fortunately, it’s easy to convert this data from stacked to time series using a 
PivotTable. 

To get started, select all the columns and rows in the table so they are highlighted in blue. 
Then go to the “Insert” tab and select “PivotTable.” 
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14. Click “OK.” This will create a new tab in your workbook that will hold the Pivot Table. It will 
look like this. 

On the right is a 
menu with all of 
the fields 
(columns) from 
your table. This 
is where you 
decide which 
will be rows or 
columns in the 
PivotTable. 
On the left is the 
PivotTable itself, 
where the data 
will be displayed 
once it’s 
rearranged. 
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15. Click on “Year” and drag it down to the box under “Column Labels.” The years you had 
selected for the trade data will now appear in the pivot table. Instead of being stacked, they 
are now columns. 
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16. Next, you want to list all the exporting countries down the left-hand side, so you can see 
imports from each country for the years in the different columns. Click “Partner” and drag it 
down to the box below “Row Labels.” The list of countries will appear on the left-hand side 
of the PivotTable like this. 
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17. Now we need to add the trade data. In the list of fields, scroll down to “Trade Value (US$).” 
Click on it and drag it to the box under “∑ Values.” Make sure it says “Sum of Trade Value 
(US$).” If it says “Count,” it just counts the number of times that there is data for that 
country for that year. That’s not what we want.  
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18. If it does say “Count,” rather than “Sum,” 

just click the button where it says “Count 
of…” and select “Value Field Settings.”  
A window will open. Select “Sum” under 
“Summarize value field by.” Then click 
“OK.” 
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19. The PivotTable may have the most recent year of data as the first column with earlier years 
to the right. This isn’t the best way to view time series data, but it’s easy to fix. Where it says 
“Column Labels,” there’s a small, grey button with a triangle. Click that and a menu opens 
up that allows you to sort the columns. Click “Sort Smallest to Largest.” This will change it 
so the earliest year is on the left.  
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20. Now we’ll move the data into another tab so 
we can analyze it. Select the data in the 
Pivot Table and copy it (Ctrl + C for 
Windows computers). Or you can go to the 
“Home” tab at the top, under “Clipboard,” 
and click “Copy.”  
Open a new tab in your workbook. Right 
click and select Paste Special > Paste as 
Values. Or you can go to the “Home” tab at 
the top, under “Clipboard,” and click Paste 
> Paste as Values. This eliminates the 
formatting from the Pivot Table and gives 
you a worksheet you can analyze. 
Now the data is sorted alphabetically by 
country, which isn’t very useful. To make it 
so you can sort the data by the trade 
values, click anywhere within the data in the 
table. Then under the “Home” tab, under “Editing,” click “Sort & Filter” and then “Filter.” 

21. Now each column of your data will have a button that allows you to sort the entire table by 
the values in that column. If you click on the button in the “Grand Total” column and click 
“Sort Largest to Smallest,” the table will show the largest exporters of lawnmowers to 
France at the top.  
Ignore the row for Grand Total because it adds up both the individual countries and the 
World, so it’s double counting the data.  
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Now that you have the data formatted correctly, you can use regular formulas and graphs 
to analyze it.  
For example, it looks like for the years 2013-2016, the United States was the largest 
exporter of lawnmowers to France, but French imports of lawnmowers overall decreased 
over the period, falling by nearly 17 percent. Imports of lawnmowers from the United States 
also decreased slightly. Meanwhile imports from China rose by more than 9 percent. What 
might these trends mean for your product in this market?  
It’s also important to think about the relationship between the target market and other major 
exporters to that market. Here, several of the other major exporters are also members of the 
European Union. So they have some advantage in that they are all part of a single market 
along with France. Think about whether other major exporters have trade agreements with 
your target market. Are they located closer to your target market, so transportation would 
be easier? Do they share a common language or culture that would facilitate doing 
business in your target market? 
  

THE TRADE POLICY INFORMATION SYSTEM 

The Trade Policy Information System (TPIS) is a trade data resource managed by the 
International Trade Administration. It can be found at http://tpis.trade.gov. 
While some of the data is restricted to government users only, TPIS does have some helpful 
aggregated tools that use both the international UN Comtrade data and U.S. government data 
and display the information graphically.  
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TPIS COUNTRY REPORT 

The TPIS Country Report on the left-hand side gives you a fact sheet of high-level information 
about a country over time, including its population, GDP, overall trade figures, and top trade 
sectors. Just choose the country you want to see from the menu. 
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U.N. TRADE – TOP PARTNERS REPORT 

Another report on the TPIS homepage, the U.N. Trade – Top Partners report, can give you a 
quick snapshot of a country’s trade patterns for a given product.  

Here we’ve again chosen France in the menu where it says “Change Country To.” 

  

Under “Product,” chose the first two digits of your HS number. This is the HS “chapter” your 
product is in. Our product is still the lawnmowers in 843311, so we select chapter 84. 

  

  22



For Informational Purposes Only

Then choose the product under “Product Detail.” Here we’ve chosen 842211 for the 
lawnmowers. 

  

The report will then show you the top import suppliers for France (who is exporting to France) 
and the top export markets (where is France exporting). It gives you pie charts and line graphs 
over time.  
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Below the charts is a table with the trade data, shares and change over time. 

  

There’s a similar U.S. Top Partners by Product report that can show you where the U.S.’s top 
export destinations for your products are. 
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USA TRADE ONLINE 

USA Trade Online is a site from the United States Census Bureau. It contains detailed U.S. 
trade data. This is data where the U.S. is the reporter, such as U.S. exports to the world or U.S. 
imports from the world.  
Using U.S. export data can be helpful because you can get more detailed data beyond the six-
digit level used in the tool. This data can more precisely show the trade patterns for the 
product you are exporting because you can find the trade data for the exact Schedule B 
number of your product.  
Let’s take a look at the Schedule B numbers for our chosen product, lawnmowers in HS 
843311. Here are the Schedule B lines. 

There are broadly three groups: electric mowers, riding mowers that aren’t electric, and other 
lawnmowers. Then there are more detailed lines for mowers of different horsepower. So you 
can see how having more specific trade data could be helpful as there are many different kinds 
of lawnmowers. 
Let’s imagine that our lawnmower is electric (so it would be in 8433.11.0010) and see what the 
trade data looks like in USA Trade Online.  

- - Mowers for lawns, parks or sports grounds:

8433.1
1 - - - Powered, with the cutting device rotating in a horizontal plane:

8433.11.0010 - - - - Electric mowers, including battery operated

- - - - Riding mowers, other than electric:

8433.11.0020 - - - - - Under 5.2 kW (7 hp)

8433.11.0030 - - - - - 5.2 kW (7 hp) and over but under 7.46 kW (10 hp)

8433.11.0040 - - - - - 7.46 kW (10 hp) and over

- - - - Other:

8433.11.0050 - - - - - Under 3.7 kW (5 hp)

8433.11.0060 - - - - - 3.7 kW (5 hp) and over
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1. After you create an account for the site and log in, you’ll see the front page. It looks like 
this: 

  
2. Select “Exports” next to “Harmonized System (HS) District-level Data. 
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3. There are tutorials for how to use the site here in the top left corner. But we’ll go through 
a basic search in this document. 

  

4. Type the HS number in the box. In this case, 843311, and hit enter.    

  

5. Choose the line for electric lawn mowers.  
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6. On the left-hand side in the panel labeled “Report contents,” click “Country.” This will 
open the window to choose the export markets. Click the plus sign next to “World Total.” 
You’ll see a list of all the countries. Above the country list, click the green check mark 
that says “Select all Level 2.” This will select all the countries.  
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7. On the left-hand side in the panel for “Report contents,” click “Time.” Select the years of 
data you want.  
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8. View the report. At the top of the screen, just below the dark blue header, select 
“Report.” 

  

9. The report will appear. You’ll see that the data’s format isn’t particularly helpful with the 
countries along the top. But the report is like a pivot table, so it’s easy to fix. 
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10. To fix this grab the country box where the dots are in the corner. Drag the Country box 
down to the orange Commodity box and let go.  

  

11. Now the report should look like this. 
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12. Now Drag the commodity block up to the gray box where it says, “Drag dimensions 
here so they do not show as a row or column in table.” Your report should now look like 
this.  
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13. You can use the arrows to sort the data and analyze it within the database. Or you can 
export the data using the download function and analyze it in a spreadsheet. 

   

With this data, you’ll be able to see the U.S. export patterns over time for the specific kind of 
lawnmower you export, rather than all lawnmowers. 
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